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= B R AS ORFIE iDrive) | DURBIAHERET -

(%4757%]

— ~ %z Debian 10 REf, ZITHREIIR 386 BE; HINEARFHHRE{BEIAMERE
.

sudo dpkg —-—add-architecture i386 && sudo apt update && sudo apt upgrade

T~ Z2EE Wine

sudo apt install wine

HEl& 4.0 hix, KR/t 925 Mo

= ~ Z#E PlayOnLinux

sudo apt install playonlinux

HElZ 4.3.4 K, $&£ 110 Mo
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mEMAETHY, BIMRIAR], AHEEAE LI NERY TCBReader 2016 FU2 2810 B
FEMERRRERRF (687 M), BAERIAA] LA -

MD5: e35180f74fc3ea2071ebb8dacbo63847

H ~ £ PlayOnLinux HZ-#E CBReader
(1) #4fT PlayOnLinux °

TR, HEIEH .desktop 1%, Frll, TEREZCEEFEZE °

Y BE

@ # LT TR [Install] #%§H; B—KEITE N EEHETER -
HEELFIERE R, HAESE, BEEST N —2EREIR

File Display Tools Settings Plugins Support Help

> m e > 4 o] Q
Run Close Install Remove Configure

Actions

PlayOnLinw

* |nstall a program
"= Settings

(3) BLEAHE /AL N /7 [Install a non-listed program] jEZE °


https://drive.google.com/open?id=1BGdsLxasTvWlRWamfYvCElOwjxMNRul6
https://drive.google.com/open?id=1BGdsLxasTvWlRWamfYvCElOwjxMNRul6

E < &8 =« E @ B B =

Accessories  Development  Education Games Graphics Internet Multimedia Office Other

Install 2 non-listed program Cancel

g EHEE.

PlayOnLinux Wizard .
Please read this ‘
During a PlayOnLinux installation:

- Leave the default install directory unchanged; Just make sure to install to
the C: drive, which is the only one managed by PlayOnLinux. Check in the

wiki how you can manage the host system disk space;

- If asked, don't let the installer launch the newly installed program for you
at the end of the installation:

- If asked if you wish to reboot Windows immediately, you may answer Yes,
but in no case should you reboot the host operating system by yourself.

@Dn’t remind me anymore

- BoREAHE NEBEHEHB
-« BRI E RN R P E B LR RIS
- B AEKREBRG, WLUE Yes, HEMBANEHOREE -

A]/A3# /AN [Don't remind me anymore] e
¥ [Next] o




@ HBLLIFEE

PlayOnLinux Wizard

Please read this

..‘
PlayOnLinux is not related to WineHQ.

To ensure that the results will be comparable from one computer to another
and to avoid regressions, we specify a working Wine version for each
program. This Wine version will quickly become out to date, but we won't
change the installer until new tests are made and it takes time.

For those reason, please do NOT send any bug report or ask any suppart on
WineHQ forums if you are using PlayOnLinux.

If you want to help the project to make some tests in order to avoid using out

te Wine versions, do not hesitate to go on our website.
on't remind me anymore

'\

Cancel

TEERE: HAME, TNEE Wine MEuhIRT, KB4 -

n]/a AN/ [Don't remind me anymore] o
1 [Next] o

(5) H¥ [Manual installation] EHE o

Manual installation

Welcome to PlayOnLinux manual installation wizard.

This script will allow you to install any program on
PlayOnLinux and use it with all the tools

Warning: We are unable to guarantee that your
application will work perfectly.

layonlinux




% [Next] o

(6) BEzE 2 [PlayOnLinux Wizard] &#& o

PlayOnLinux Wizard

Manual installation

What would you like to do?

Install a programin a new virtual drive

Edit or update an existing application

Cancel

R FEFZEEIESE —, 3£ [Install a program in a new virtual drive] o

% [Next] o

(7) Wi\ AR B 2 o

PlayOnLinux Wizard ’
Manual installation ‘
"\ ;

Please type a name for your application’s virtual drive.

i ' i aces,
iDrive |

Cancel




R LA ibrive Auff o

1% [Next] o

(©) 3R B R EA S -

PlayOnLinux Wizard
Manual installation

What would you like to do before installation?

u don't know. unselect all
se another version of Wine

onfigure Wine
nstall some libraries

EEANE, % [Next] o

(9) #) il R RERE TR A o

PlayOnLinux Wizard
Manual installation

What kind of virtual drive do you want to create

32 bits windows installation

B4 bits windows installation




# 32 NITE, £ [Next] e

B SHOME/.PlayOnLinux/wineprefix/iDrive H$k

(338 64 AITE
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PlayOnLinux Wizard

Manual installation

Please select the install file to run.

Browse

Cancel

% [Browse] & TEIIZL 4T

% [Next] o
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Choose ampans nte

Setup will install CBEReader 2018 in the following folder. To install
in a dif ferent folder., click Browse and select another folders.
Click Install to start the installation.

Destination Folder

B
Space required: 1.3GE
Space available: 4. 7GE
Back B Install [J Cancel |
= - -

Inetalling

Flease wait, it may take a fewm moments to decompress il

= Bachk | Hext = I Cance]

Completing the CBReader
2016 Setup Wizard

Biles el 18 has been installed on your
i Ler .
lick Finish t 1 this wizard.
= Back K Finish # Cancel
i -




Zatup has been completed. Press [Yes| to
open README Tile.

Yes

19 EEFERR o

PlayOnLinux Wizard l ’

Manual installation

Please choose a file for PlayOnLinux to make a shortcut

4" | don't want to make another shortcut

Q, Browse

@‘f.‘r cbreader.exe
cbr_setup.exe
ﬂ install_font.exe

@ uninstall.exe
4" wmplayer.exe

:'j wordpad.exe

Cancel

122 cbreader.exe, 1% [Next] o

13 BLE N1 B R PEE A2 R -

PlayOnLinux Wizard
Manual installation

Please choose a shortcut name for chreader.exe
chreader




ARBIANEE R

1% [Next] o

) HMREKR, BOBEEH -

w1z, ®B%E—TH [I don't want to make another shortcut] °

% [Next] o

PlayOnLinux Wizard ‘.

Manual installation
—h

Please choose a file for PlayOnLinux to make a shortcut

| don't want to make another shortcut

Q, Browse
cbr_setup.exe

ﬂ install_font_exe
@ uninstall.exe

{' wmplayer.exe
-:‘iuwordpad.exe

(%) CBReader 2016.Ink

Cancel
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[Software\\Wine\\Fonts\\Replacements]
"MingLiU"="Noto Sans Mono CJK TC Regular"
"PMingLiU"="Noto Sans CJK TC Regular"
"SimSun"="Noto Sans CJK SC Regular"

MR AMAA ZHE A “AR PL Wing” FRIZEEHREE, A

[Software\\Wine\\Fonts\\Replacements]
"MingLiU"="AR PL UMing TW"
"PMingLiU"="AR PL UMing TW"
"SimSun"="AR PL UMing CN"

fFE7F, BARASCERES -

(L NFHEMF]

— ~ JX#) PlayOnLinux, EFREEMIEAY coreader FER, RRIZLEFTHY
[Configure]| #%4f -

File Display Tools Settings Plugins Support Help

> | . ®

Run Close Install Eemove

Actions N
@ cbreader

PlayOnLinw

* |nstall a program
"= Settings

cbreade

Run
Close

Debug

Configure
Create a shortcut

Qpen the directory
Uninstall
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T ~i® [Install components| 43 H; Z#E [Internet Explorer 6] o

2 default 1 General Wine Install components Display »
2 iDrive
'j@ Install

Be careful! Installing one of these components can break your virtual drive.

-—

& Hacksteam

- -
» Internet Explorer 6

&" Internet Explorer 8
& itch

& ivs0

& linuxtrack-wine
am

@ LunaTheme

&" mdac28

L
MNew Remove "_: mfc40
PlayOnLinux Wizard ’
cbreader ‘

Please read this carefully

@Agree
Cancel

CBEANEIEBAREA B AR —2E - )




PlayOnLinux Wizard

Microsoft fonts

Microsoft fonts aren't installed; I'll install them for you.

Cancel

PlayOnLinux Wizard ’
Microsoft fonts ‘

Please read and accept the following:

@Agree
Cancel




Welcome to Setup for
Internet Explorer and Internet

The Windows Update setup wizard guides
through installation of Internet

features
Please read the following license
agreement. You must accept the agreement
i il L

SUFFLEMENTAL EXND USER LICENSE AI
AGREEMENT FOR MICROSOFT SOFTWARE
IMPORTANT: READ CAREFULLY - These

Microsoft Corporation ("Microsoft”)
operating s

tem components; including
or electronic documentaticon

{05 Components") are subject to the v.I
. — Peap— ] S EIA — r a e - —— ————

3

any ~online

accept the agreemend

i don't accept the agreement

= Bach

—
Next = > Cancel Help

YWindows Update: Internet Explorer and Internet Tools

Windows 2000 / Windows XP Install

Install includes: Internet Explorer 6 Web Browser, Outlook E
and Scripting support.

= Back l Next = | Cancel Help
— .




Restart Computer

Flease save your work and then close
applications before continuing.

al

Thank you for choosing Microsoft produoc

—

= Back M Finish l Cancel i

Help

PlayOnLinux Wizard

cbhreader

Registering libraries, please wait
(It can take a while)

inetcpl.cpl

Cancel
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2 default

= iDrive
cEm
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Remove

L General Wine Install components Display »

Install

Be careful! Installing one of these components can break your virtual drive.
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nop
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— ~ ZZd4E FontForge o

sudo apt install fontforge

F 22 Mo

R
$HOME/ . PlayOnLinux/wineprefix/iDrive/drive c/windows/Fonts/Siddam.ttf o ¥
B A, H FontForge B o (MW FANE, 2R %M AMITIEH CBReader © )

= ~ £ FontForge i#fTLL FH{E »

[Encoding| > [Reencode]| > [ISO 10646-1 (Unicode, Full) |

File Edit Element Hint{ Encoding Yiew Metrics CIp M  Custom
Glyph Order
- = Reencode _
@ A 3] C D™ . N O
=Cees 1SO 8859-1 (Latinl)
Force Encoding ISO 8859-15 (Latin0)
P Q B g T IS0 8859-2 (Latin2) —~

Add Encoding Slots... 1SO 8859-3 (Latin3) -

IS0 8859-4 (Latind)
IS0 8859-9 (Latin5)
ISO 8859-10 (Lating)
150 8839-13 (LatinT)
Add Encoding Name... 1SO 8859-14 (Lating)

P_| 4 J 5 t . ~
Load Encoding... ISO 8859-16 (Latinl0 i

Remove Encoding... 1SO 8859-5 (Cvrillic)

KOI8-R (Cyrillic

150 8859-6 (Arabic
Define Groups... ISO 8859-7 (Greek)

150 8859-8 (Hebrew
Save Namelist of Font... ISO 8859-11 (Thai)
Load Namelist...
Rename Glyphs...
Create Mamed Glyphs...

Macintosh Latin
Windows Latin ("ANSI")

Adobe Standard
Symbaol
Tex Base (8r

150 10646-1 (Unicode, BMP)
150 10646-1 (Unicode, Full)

SIS (Kanji
JIS 208 (Kanji




[Element] >

[Font Info] > [PS Names] > [Fontname]| > P{A Siddam > [OK]

General
Layers
PSUID

PS Private
05/2

TTF Names
StyleSet Names
Grid Fitting
Tex

Size
Comment
FONTLOG

Fontname:

Sidda
Siddam

Family Name:

Name For Humans: |Siddam

Weight [Bnuk

Version: 1.0

sfnt Revision: 1.0625

© SameasFontname

Base Filename: (

LS

Copyright:

P

Mark Classes
Mark Sets
Lookups

WOFF

Mac

Mac Features
Dates

Unicode Ranges

q

Ce)

[File] > [Generate Fonts]| > FEZRFEAE TrueType > FE44 Siddam.ttf > AJHUH

[Validate Before Saving]| > [Generate| > [Replace]

Fonts v
i
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gub.tif
gui.ttf
gur.ttf
ImpactTTF l
Ranjana.ttf
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1]

Tahomabd.TTF
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[ Options l

Mo Bitmap Fonts

Force glyph names to: Mo Rename ~

[\ validate Before Saving
Append a FONTLOG entry
Prepend timestamp

[ Filter ] lﬂew[i]l lgancell .
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[Encoding]| > [Reencode]| > [ISO 10646-1 (Unicode, Full) |

[Element] > [Font Info] > [PS Names| > [Fontname]| > A% Siddam
[Element] > [Font Info] > [General] > [Em Size]| > FHiEEFIE 1000 > [0K]

[File] > [Generate Fonts] > FEZFAAE OpenType (CFF) > f&44 Siddam.otf > AJHY
?ﬁ [Validate Before Saving]| > [Generate]

.~ BAR FontForge tH&E, NSNFEREEF -

~ R R H # o
WF A CBReader & HE|, HTE:

SHOME/ .PlayOnLinux/wineprefix/iDrive/drive c/windows/Fonts/

MAREHCHMSGEFHE, BHE:

SHOME/ . fonts/

MRRBGHMG AT HE], BE:
/usr/share/fonts/ (#7H truetype BY opentype H$f, mltE ) o

DLEZBF—REA, (EARZE ttf fil .otf FRFE - —HE, ARHEE—ERN,; B—
T, FIEEERIRIE o otf MEMRITE (ttf FERY 374 fEK o

£ ~ J&E) CBReader, WRADBEFIAME, 1 IFEHE 12132 (BEFEL)
(T54, No. 2132) -



I\~ BALF RIS Ranjana. ttf WTMEARIBIN - SRALTRIESL  TEHEES
1 X1079 (iR A SIEE)  (X59. No. 1079) -

oK

U~ RFRGHGR, S EERER, EHXCARIEFEBRIE, mETRERN BT
[H 2N e B OB -

(B (X&) 73]

— ~ CBReader W& Al AAAMIE, Zdhe (HEkE]) ; A8 e (], T
Fhse (e ) | Hge (R |, AiEEtaE e

T CGBRETRD) TLUER (EXXE) FERBEEREILREER, IERBRG
IEFER TR © [ROCBUE T RARZ Windows [, Linux RERIRATHIGEL © 11
CBReader HY [ETHEUE] HEERETHIEAET ~ K/, FrLAZH €SS MEAGRAE

i

=B

SHOME/ .PlayOnLinux/wineprefix/iDrive/drive c/CBETA/CBReader/cbreader.css °

JFIEHBARM %, Pl B EHE; bl istyle.css Hffi o

PO~ %& T HaHXXFR, B vody e (X&) BEATH, DEREHHRE - &
LEIYIIVAN

font-family: Noto Serif CJK TC Regular, AR PL UMing TW;

Google WY Noto FHUHIZE Debian FEMHY A SR AR, THERFARAY o
SCHEAY “AR PL UMing TW” /& Linux RAFEH AU CFER, BUl Windows HYFTAHAAR

S
FREFCTATRER /D 15pt AR G0

font-size:15pt;

FIORT, ATEEEINA



line—height:20pt;
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font-family: Gandhari Unicode, #HEA#E, #HAHRE-ExtB, SimSun, Arial Unicode MS;
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[Wine #KBE]

— ~ §HR1F CBReader HYHTFR/NUE? AIREHCK, HLUFFH:

1. 7F PlayOnLinux FHHEELHE cbreader FELR o

2. ¥% 77 [Configure] %%l °

3. 1% [Wine] ﬁj\E °

4. ¥ [Configure Wine] o

5.7# [Graphics] 0H o

6.1 [Screen resolution]| M A 1007120, R4 ANEIFME
7. %% [OK] MR o



8. X CBReader o

|2 default

| iDrive
e

1 General Install components

Win

Configure Wine

Q)

Registry Editor Windows reboot

Display »

3

Repairvi
driwvi

it

rWindow settings

I_ Avtomatically capture the mouse in full-screen windows
IF Allow the window manager to decorate the windows
IF Allow the window manager to control the windows

l_Emul.:tc a virtual desktop

rScreen resolutiom

J G

This is a sample text using 10 point Tahoma

N R Command Task manager Kill processes Contro
2W 2move
orompt
Drives I Audia I About
Applications I Libraries Graphics | Desktop Integration

WAB S $RTE B $kFE SHOME/ .PlayOnLinux/wineprefix/iDrive/user.reg o [Software\\
Wine\\Fonts]| HHY "LogPixels"=dword:00000064 Bl-Z o M, F7SiEAMIRY 64 BN
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Drives I Audio I About I
Applications I Libraries I Graphics Desktop Integration
rAppearance

Theme :
[ (¥o Theme) | Install theme. . |

Item: olar: ize:
( - | Iﬁ;l Eant, .. |

o
Active DOFOET -
Factive Title Bar
Active Title Bar Gradie
Active Title Text
—f'|_|-||-|| ication Workspace
Controls Alternate Back
Controls Background iz I
Controls Dark Shadow 11/ Besktop
Controls Highlight 11 Documents
Controls Light 11 /Pictures
Controls Shadow 11 Music
Controls Text 11/Videas
Fesktop
Gray Text
Hot Tracked Item Browse: |
—|Inactive Border
il [nactive Title Bar

Inactive Title Bar Grad N | |
Inactive Title Text - I Cancel HEPLY

) RFEI|FESE [Menu Text]; KFKHEHIE [Color] MFE, [Font...] HFH

(2) CBReader & I 7 HIITRESITER 2 HIEE R AR EH B 50 - R ZEH
Wine ¥, PUEHBAGMFR, HIEF L, HE%®E [Graphics| 2 H, #% [Allow
the window manager to decorate the windows]| HUJHA)E o

Drives I Audio I About

Applications I Libraries Graphics

Desktop Integration

rWindow settings

Automatically capture the mouse in full-screen windows
I_:,-Ill-:nr the window manager to decorate the windowk

Allow the window manager to control the windows

I_ Emulate & wvirtual desktop

—Screen resolution

J IT dpi

This is a sample text using 10 point Tahoma

* oK } Cancel Apply




INBAE [Ttem] THOEFEZEBEHAIEE:

i R B AR S
JefRlET R 2 [Active Title Bar]
ARl g B2 [Active Title Bar Gradient]
VF S [Active Title Text]

A PR E RS
JefRlEr g B2 [Inactive Title Bar]
ARl g 22 [Inactive Title Bar Gradient]
VF 4 [Inactive Title Text]

(3) %hEREDBETEEEkFE SHOME/.PlayOnLinux/wineprefix/iDrive/user.reg 9, Fi1E
FEEEMTIT © JRZS [Control Panel\\Colors]| T, M(E(IHE o (K LIFEMEEER, #
BN (BB GEE)  FHAAME [Control Panel\\Desktop\\

WindowMetrics] e

@ |[Graphics] 47 HEFY [Allow the window manager to control the windows] A~EE
RRHUH, DIRYIIRE & A -

6 (H#klE) RIBAE HEENESGE

« [Window Background] HENFEY =, WA AE ~ 4 BES
. [Window Frame] REFBUAMIIER, NHH -« RS
« [Window Text] FENFHM, MAUFHEMAE - BFE - BOLFEHE ~ HEHE

L)LJ:EIE:[/;E user.reg EF'ﬁj\}DJ]JIEé‘ Window > WindowFrame > WindowText ©

[CBReader HEFHE]

— BENRE R Z B -

7 IR TR, $R9B CBReader HSRFRG CSS A JS o B IFHLAT LL AT AL R
Bt -



—EAREAZEGEAHEAEN, AfRE, CBReader HWAFIIN o (HE, BRI
IDE RZ HREERN, FRENANE=ZM MR - MRFAEEENER, RIS
RHE o L, A ARG ERAME ] -

— ~ £ CBReader WIfREF, AMIEHRR T E T HEIRE o

- H— FHHHTRBEREEEEM ©

- HT ZEH T HA—FEES -
B E B R —E T 2 A AFR L (EE) P EPBAEE ARE, EAMH Wine 1
RE, ANFUA R ATEM o BRI T IR AR o
HHEGE, [Item] FHIEHAY [Controls Background]  (FEESHE MY
ButtonFace) JRE T Z MM TR E R, KR T CFE ~ #EY| ~ @Y LIS, Hil®
B E S HTEIRE o
HEHFEOTE (BEkE) ~ (FEIE] ~8AE 2% - J00HE - H5EE, 23
[Ttem] THIEEA] [Window Text| (EERFEAINY WindowText) FXIE °

NHER AR IR BB ]

= (BE)
AT REA R B TR 7 €SS #, PHBWmHLTEHIE (istvle.css) BUE ° LU MK
TFHREIEFFI4A o

W EFEBHOERKEERT, EMEMIB -

atactive {color:#80ffff;}

azhover {color:#ffa020;}7 JFIRE K a.hover ZEEHY
a:link {color:#40c0ff;}
a:visited {color:#8000ff;}# fLl-F-HERK

2 7£ body IEEA T A color F background-color F%AEIEHSHYFEELFEEH o AN A

background-color :#202020;
color:#e0e0e0;



@ divow RIS, WEUE—RAESTRRTNNT; EEZE dv TTAE span

color :H#ffa0ff;

@ div.xu EF; EERZE div /A2 span °

color:#00ff80;

() img RS HE A RAEEEY, ROEXR, BTFHEKENTRE, AENS

% -

img { background-color:#a0a0a0; }

(6) span.SearchWord e T&IMER] K, HRHBRMERILTFIERN - B A FHEE
A, PR <a> WUBRIN, FEMLEEVADE, FoHeME o

span.SearchWordl {background:#606000;}
span.SearchWord2 {background:#006060;}
span.SearchWord3 {background:#006000;}
span.SearchWord4 {background:#600000;}
span.SearchWord5 {background:#600060;}

(7) span.byline AVE/3EE o

color:#80f080;

(® span.corr RIEE]TF, AFTHRAVALEIGE —F

color:#ff6060;

(9) span.dharani SLEE, AEEFET XMBEEFT  FHEERE. BECIA -

span.dharani { color:#60ff00; }



10 span.foot BRENT, HTEHEZST, FOREES, XbTHOME, A
o B PR BGOSR (B8 (BS0E) FORBIE) (RBINA R0, e
TR -

span.foot { background-color:#000000; }

(1D span.headname 7,\%5':]% ﬂt%% o

color:#e000e0;

19 span.juanname Z4&8ER%Y o

color:#e08000;

(13 span.juannum %@%ﬁ%ﬁ °

color:#00e000;

(4) span.lg AyfERH o

color B fff80;

(15 span.linehead A3fTHE & o

color:#a0a0a0l;

(16 span.note fuEEfT/NEF ©

color:#c0c000;

a tehh, EiE (Rl ) BhEmEsiz, (Om) pnls T a s Re - HE A
lightpink, JEEEFE cbreader.js FHIHE—HBEL sr o HAGINF O AL SIRKET
ROUGE, EEMRGIREHEXTENGE, LR Buh e o flamE—=F
AL



var sr='darkred';

EERHARSHEL R, KEesH v 2EHEE - HEHRE, HF#TFE8E
ANIEHT o BT DAL E BRSO BTE — % -

var yr='darkred';

#F: AHEsE CBReader [ bug, EE (WEpE) BhEEAAR, (KOCE]) BUEESE F
ARG EMS, HIAE—EU o & () f1 (REIE) AIRscE) A AR —EE,
RS o . (RSCE ) BRAE TR (B o (&) & TRy, B aERE -

v

PO~ [ERAE 1)

1) B
SHOME/ .PlayOnLinux/wineprefix/iDrive/drive c/CBETA/CBReader/cbreader. js °

T “font-family” - FIHECE TR, WEBHILE (FEHE 242 17) -

@ EMEPR T FRSN, BT (FEE) ERAEE - HEHERERENEA L
W, BRTEARN, BEFOMESR - Wb, HROERERER, rUBEREH
JEE o eI 2R IAT - ZEREHEHE A

body {
font—-family: AR PL UMing TW, GandhariUnicode;

color: #e0e0el;
background-color: #202020;

}
table, td {

border-collapse: collapse;
border: 1px solid #e0e0eO;
}

img { background-color: #a0a0aO; }

OB BB —THE <head> H, 55 242 17phEAL.

docJK.write ("<head> <style> body { font-family: AR PL UMing TW, GandhariUnicode; color:
#e0e0e0; background-color: #202020; } table, td { border-collapse: collapse; border:
1px solid #e0eOeO; } img { background-color: #a0a0a0; } </style> </head>");




® MRRE (FAEE]) ARETHRBEAGE, fHFEESE 295 17H

docJK.write(s);

U

docJK.write(s + "<br><br>");

fo~ ()
[FIfRERL cbreader.ds, FEREAPFIIMBAZ

1) FH—E

function loadStyle() {
var footDoc = window.parent.frames.foot.document;
footDoc.body.style.color = "#e0elel";

footDoc.body.style.backgroundColor = "#202020";

footDoc.body.style.fontFamily = "AR PL UMing TW, GandhariUnicode, Noto Sans CJK TC

Regular";
for (i = 0; i < footDoc.anchors.length; i++) {
footDoc.anchors|[i].style.color = "#40cOff";
}
for (i = 0; i < footDoc.images.length; i++) {
footDoc.images|[i].style.backgroundColor = "#a0a0a0";

}

window.parent.frames. jk.document.body.style.backgroundColor = "#202020";

window.onload = loadStyle;

L EFHFE L loadStyle HY function:

O HAEITERBE footboc, B (K] BIANL o A footboc, A& [F AR
T H dockoot EFMEYIME, & THAIRE, AN —ERKIIZHE -

@ BER=ATRHDEFF body FEEAESN——F€  JIEE ~ FIFE - A[REH

NERHFTRWBEER T - HERE, EfE (Rl 1y, srms 242 178 (5
felE) [ e



@ FE—1F for loop EFHHEHLEEE -
@ FETRAY for loop +e=mEFINE S, FANEBETRERER

® RRBOE (FAEE]) JIRE - BRI S 242 TEBUE T HR, BEIGEERT
e IS fER, AEAR - i, ERHEERENELR - T E] R AT,
(i) ERIEEREE -

2. WIE— 1T BT function BURFE——F SCHFEIAIZ BN o

@ H B

BRI R T AREGRR O R EBFTRCENEE o RIS T IKIEEERRE,
f£ cbreader.exe FEEKEHAT, ML (KHE) HERNKEEEE © EHILE]
HEK B, FTLLEBTB -

function resetBackground() {

var footDoc = window.parent.frames.foot.document;
for (i = 0; i < footDoc.anchors.length; i++) {

footDoc.anchors|[i].style.backgroundColor = "#202020";

window.parent.frames.sutra.document.onclick = resetBackground:

window.parent.frames.foot.document.onclick = resetBackground;

L EFHE B L resetBackground [Y function:

@ ;H\:EF'% ﬁi‘fﬁ%z&gﬁ footDoc, %Di@ﬁ %‘%IEIL: [TEEEJ)IE] E@V‘]g ° HEEJU\TEEWZ
?IJ function ﬁl\, /\/_\Eﬁﬁfj\ ©

@ for loop FhLAEMKIEJELD, o

2. EMATARRE: £ (BXE) 5 (B ) (F—REAR— TRIBITIL
function H§JEfaEAA o



i 151 -

1] -- T54, Mo, 2132]

AREEHAIIE A, HAREGDFHE - B (HikER) BERER tooltip o AHIEAR
{7l CBReader BUEMNTEE, 1 Wine HUSKAL o MIN, BEFAIERF, ZBE T HHRGENE,
FHUHSETEZER, H0E, HEMAERET - SR E mREHAHE -

A
HRaE B HAEh




[Bffex ]

(iStyle.css)

atactive {color:#80ffff;}

athover {color:#ffa020;}

a:link {color:#40c0ff;}

a:visited {color:#8000ff;}

body {background:#202020; color:#e0e0e0; font-size:15pt; font-family:Noto Serif CJK TC
Regular, AR PL UMing TW; line-height:20pt;}

div.w {color:#ffa0Off; font-size:13pt;}

div.xu {color:#00ff80; font-size:13pt;}

img {background-color:#a0a0a0;}

span.SearchWordl {background:#606000;}

span.SearchWord?2 {background:#006060; }

span.SearchWord3 {background:#006000; }

span.SearchWord4 {background:#600000;}

span.SearchWord5 {background:#600060;}

span.byline {color:#80f080; font-size:13pt;}

span.corr {color:#ff6060;}

span.dharani {color:#60ff00;}

span.foot {background-color:#000000;}

span.headname {color:#e000e0; font-size:1l4pt;font-weight:bold;}
span.juanname {color:#e08000; font-size:16pt;font-weight:bold;}
span.juannum {color:#00e000; font-size:12pt;}

span.lg {color:#ffff80;}

span.linehead {color:#a0a0a0; font-size:13pt;}

span.nonhan {font-family:Noto Sans CJK TC Regular, Gandhari Unicode, DejaVu Sans; font-
size:13pt;}

span.note {color:#c0c000; font-size:13pt;}




[cbreader. js)

RAVEER AT -

Yaviaxd

% 51T

var sr='darkred';

var yr='darkred';

5 242 17

docJK.write("<head> <style> body { font-family: AR PL UMing TW, GandhariUnicode; color:
#e0e0e0; background-color: #202020; } table, td { border-collapse: collapse; border:

1px solid #e0eOeO; } img { background-color: #a0a0a0; } </style> </head>");

% 295 17

docJK.write(s + "<br><br>");

RN

function loadStyle() {
var footDoc = window.parent.frames.foot.document;
footDoc.body.style.color = "#e0e0eO";

footDoc.body.style.backgroundColor = "#202020";

footDoc.body.style.fontFamily = "AR PL UMing TW, GandhariUnicode, Noto Sans CJK TC

Regular";
for (i = 0; i < footDoc.anchors.length; i++) {
footDoc.anchors[i].style.color = "#40cOff";
}
for (i = 0; i < footDoc.images.length; i++) {
footDoc.images|[i].style.backgroundColor = "#a0a0a0";

}

window.parent.frames. jk.document.body.style.backgroundColor = "#202020";







(user.reg)

RAVEER AT -

[Control Panel\\Colors]
"ActiveBorder"="224 224 224"
"ActiveTitle"="32 32 32"
"AppWorkSpace"="128 128 128"
"Background"="128 128 128"
"ButtonAlternateFace"="128 128 128"
"ButtonDkShadow"="160 160 160"
"ButtonFace"="64 64 64"
"ButtonHilight"="160 160 160"
"ButtonlLight"="64 64 64"
"ButtonShadow"="64 64 64"
"ButtonText"="192 192 192"
"GradientActiveTitle"="192 192 192"
"GradientInactiveTitle"="0 0 0"
"GrayText"="128 128 128"
"Hilight"="192 192 192"
"HilightText"="32 32 32"
"HotTrackingColor"="128 128 128"
"InactiveBorder"="128 128 128"
"InactiveTitle"="32 32 32"
"InactiveTitleText"="192 0 0"
"InfoText"="255 255 255"
"InfoWindow"="128 128 128"
"Menu"="64 64 64"
"MenuBar"="128 128 128"
"MenuHilight"="128 128 128"
"MenuText"="224 224 224"
"Scrollbar"="96 96 96"
"TitleText"="224 224 224"
"Window"="32 32 32"
"WindowFrame"="192 192 192"
"WindowText"="224 224 224"

[Control Panel\\Desktop]
"LogPixels"=dword: 00000064




[Control Panel\\Desktop\\WindowMetrics]

"BorderWidth"="1"

"CaptionFont"=hex:0c,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,90,01,00,00,\
00,00,00,00,00,00,00,22,4e,00,6f,00,74,00,6f,00,20,00,53,00,61,00,6e,00,73,\
00,20,00,43,00,4a,00,4b,00,20,00,54,00,43,00,20,00,52,00,65,00,67,00,75,00,\
6c¢,00,61,00,72,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00

"CaptionHeight"="-274"

"CaptionWidth"="-274"

"MenuFont"=hex:0c,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,90,01,00,00,00,\
00,00,88,00,00,00,22,4e,00,6f,00,74,00,6f,00,20,00,53,00,61,00,6e,00,73,00,\
20,00,43,00,4a,00,4b,00,20,00,54,00,43,00,20,00,52,00,65,00,67,00,75,00,6¢c,\
00,61,00,72,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00

"MenuHeight"="-274"

"MenuWidth"="-274"

"MessageFont"=hex:0e,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,90,01,00,00,\
00,00,00,00,00,00,00,22,4e,00,6f,00,74,00,6f,00,20,00,53,00,61,00,6e,00,73,\
00,20,00,43,00,4a,00,4b,00,20,00,54,00,43,00,20,00,52,00,65,00,67,00,75,00,\
6c¢,00,61,00,72,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00

"ScrollHeight"="-245"

"ScrollWidth"="-245"

"SmCaptionFont"=hex:09,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,90,01,00,\
00,00,00,00,88,00,00,00,22,4e,00,6f,00,74,00,6f,00,20,00,53,00,61,00,6e,00,\
73,00,20,00,43,00,4a,00,4b,00,20,00,54,00,43,00,20,00,52,00,65,00,67,00,75,\
00,6¢,00,61,00,72,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00

"SmCaptionHeight"="-302"

"SmCaptionWidth"="-230"

"StatusFont"=hex:0d,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,90,01,00,00,\
00,00,00,88,00,00,00,22,4e,00,6f,00,74,00,6f,00,20,00,53,00,61,00,6e,00,73,\
00,20,00,43,00,4a,00,4b,00,20,00,54,00,43,00,20,00,52,00,65,00,67,00,75,00,\
6c¢,00,61,00,72,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00

[Software\\Wine\\Fonts|
"LogPixels"=dword:00000064

[Software\\Wine\\Fonts\\Replacements]
"MingLiU"="Noto Sans Mono CJK TC Regular"
"PMingLiU"="Noto Sans CJK TC Regular"







